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Kurzweil 3000 v.9.x (Windows) 
 
Using the Word Processing Features to Support Writing 
 
Introduction 
 
Kurzweil 3000 has many customizable features which support students who struggle 
with reading and writing.  The program’s word processing features, particularly the text-
to-speech options, provide significant support to students struggling with written output.  
Students can also use the built in word prediction feature to help with word finding and 
sentence construction and the program’s toolbars can be customized to create an 
individualized word processing environments tailored to meet the unique needs of the 
student writer. 
 
Case Study 
 
Students of all ages can use the word processing features built into Kurzweil 3000 for 
Windows.  The program supports a continuum of student writers – from those who just 
require simple auditory feedback for editing once they have finished writing, to those 
who require full auditory support and word prediction while composing. 
 
Sandi is a Grade 7 student who has always struggled with written output.  While she is 
reading and comprehending at a Grade 5 level, her writing is at least two grade levels 
below that.  She has some difficulty with visual discrimination and, during class 
discussions, relies on her stronger auditory processing skills to understand the concepts 
presented and the instructions given.  Her team began using Kurzweil 3000 to have her 
written output more closely reflect her cognitive understanding. 
 
The team began by examining the tools that were available with the program and then 
chose to customize the toolbar to include the few main tools that she needed while 
working.  They also decided to increase the auditory feedback by having the program 
read words and sentences while she typed.  Sandi uses this feature to catch mistakes as 
she types, but also uses the “Read Text” feature to read her writing at the end for 
general organization and editing.  One of the tools her team made accessible was the 
word prediction tool which she can use when she feels she needs it.  Her team creates 
specific Vocabulary Lists based on themes or topics she is writing about and this has 
really helped her develop vocabulary and has improved her overall spelling as the 
months have passed. 
 
Sandi began by using Kurzweil 3000 for simple writing tasks once every few days.  As 
she learned how to use the program, her team moved more and more of her writing 
assignments over to be completed on the computer using the program.  She still 
completes work by hand when needed, but is now motivated, because of her success, to 
use Kurzweil several times a day.  When she needs to work on assignments at home, 
she saves her work as a Word (.doc) file so she can open it at school using Kurzweil 
3000 to edit and print it.  She transfers her files back and forth on a USB Flash Disk. 
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Learning Objectives 
 
Completion of this tutorial will give you experience with the following: 

• Creating a word processing or text file 
• Using the tools on the Main and Reading Toolbar to read text 
• Using the Reference tools on the Main Toolbar for vocabulary support 
• Adjusting the Toolbars to customize the word processing environment 
• Adjusting the General, Reading, and Text Options 
• Using the Word Prediction feature for writing support 
• Creating a custom Vocabulary List 

 
Installing Kurzweil 3000 (Windows) 
 
Before beginning this tutorial, please refer to the Installation instructions that came with 
your Kurzweil 3000 program.  Before you are able to use your program, you must 
register your copy either by phone or online (these instructions also came with your 
program). 
 
Starting the Program 
 

1. Launch Kurzweil 3000  by double clicking the alias on your desktop or 
selecting it from your “Start – All Programs” list. 

 
2. When the “Tip of the Day” window opens up, close it by clicking in the “red 

close box” in the upper right corner of the window. 
 

 
 
 
 
 
 
 

 
Opening a Word Processing or Text File 

 
When Kurzweil 3000 opens up for the first time, you will see what is called a “Classic 
Toolbar SetUp” at the top of the screen.  This set up has two toolbars – the Main Toolbar 
and the Reading Toolbar. 
 
 
 
Main Toolbar 
 
 
Reading Toolbar 
 

1. To start a new text file, click the “New” button on the Main Toolbar, or go to 
“File” and select “New – Text File”. 
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A blank text tile will open up.  
 
Type several lines of text into 
the text file. 
 
 
 
 
 

2. The “text reading” tools are accessible from the Main and Reading Toolbars 
as well as under the “Read” menu.  Click to place your cursor at the 
beginning of your text.  Click the “Read” button (green arrow) 
located on the Main Toolbar. 

 
Notice that the text is highlighted and read aloud.  Click the “Pause” button to 
stop reading. 
 

3. Click the “Back” button (red back arrows) and the “Forward” button (red 
forward arrows) to move your cursor back and forward in the body of your 
typed text. 

 
4. The Reading Toolbar contains tools to help you control 

the text reading feature.  The first tool on the toolbar is 
the “Reading Mode”.  By clicking on it, a drop down 
menu appears giving you the option of text reading 
“Continuously” (without stopping), “Self-paced” (stopping at the end of each 
reading unit) or “Word by word” (self-explanatory).  Try each one and 
consider how the choice of reading mode would depend on what editing task 
the student was completing. 

 
5. Next to the Reading Mode on the Reading Toolbar is the 

“Reading Unit” tool.  This drop down list gives the student 
control over what unit is being read at one time.   

 
For example, if the student wanted to listen to his or her 

work, one sentence at a time, “Self paced” by “Sentence” could 
be selected.  Try some of the choices to see how the program 
reads the different units. 

 
6. The Reading Toolbar also contains a tool for adjusting the 

speed of reading.  By clicking the “increase” and 
“decrease” arrows next to the WPM, the student can find a 
reading speed that is fast enough for fluency but slow enough to 
comprehend. 

 
7. If the student does not require auditory support but does need help 
with tracking, he or she can click the “Audible – Silent” button on the 
Main Toolbar.  This toggles auditory feedback on and off.   
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Notice that all the Reading tools and features found on the 
Toolbars, are also available under the “Read” menu.   
 
 
 
 
 
 
 
 
 
 
Using the Main Reference Tools 

 
There are several reference tools available on the Main Toolbar to help students develop 
their vocabulary while writing. 
 

1. The “Definition” tool gives students a definition of a selected word.  
Highlight a word in your text and then click “Definition”.   

 
The definition of the selected word will open in a separate document.  You can use the 
text reading tools on the toolbars to read that definition aloud making it easier for 
students to understand the definition. 
 
Depending on what dictionaries have been 
installed, you can adjust the language level of 
the definitions by going to the “Reference” 
menu and choosing “Select Dictionary”.  
 
A list of installed Dictionaries will come up.  
Notice in this example, you could choose the 
“American Heritage Children’s” dictionary  
to get a simpler type of definition. 
 
Try choosing a different dictionary to see the 
difference. 
 
 
 
 
 
2. There are other Reference tools available on the Main 
Toolbar.  Highlight words in your text file and click on each one to 
see how the “Synonym”, “Syllables”, and “Spell” features work.   
 
Notice that the Reference tools are also accessible 
under the “Reference” menu or by clicking the 
keyboard shortcuts listed. 
 



 
Provincial Software Acquisition Plan  February 2006 5

Selecting a Different Toolbar Set 
 

Kurzweil 3000 comes with a number of different Toolbar Sets that have been designed 
for specific reading and writing purposes.  You have been working with the “Classic” 
Toolbar Set.  You can activate any of the other set ups at any time. 
 

1. Right-click anywhere on the Main or Reading Toolbar (put your cursor 
somewhere over the toolbar and click the right mouse button).  A context 
specific menu will open up giving you a number 
of options around the Toolbars.   

 
On this menu, you can see the four types of toolbars that 
the program has – the Main, the Study Skills, the Reading 
and the Writing toolbars.  In the “Classic” Toolbar Set, only 
the Main and Reading toolbars are visible. 
 
If you had a student that had difficulty with overclicking 
tools, you could choose to have the Main toolbar and Reading toolbars turned off entirely 
(choose “None”) and deselecting.   
 

2. Notice that one of the choices on the 
context menu is “Apply Toolbar Set”.  
Selecting that item pulls up the list of 
available Toolbar Sets.   

 
Some of the Toolbar sets are more applicable to 
word processing tasks than others.  Choose the 
“Proofreading” Toolbar set and note how the tools 
have changed on the Main Toolbar.   
 

 
The Proofreading Toolbar Set gives student easy 
access to text reading, spell checking, word prediction, reference, reading and formatting 
tools (which makes sense given the task). 
 
By using the available Toolbar Sets, you can set up the word processing environment to 
be more specific to the needs of the student and word processing task. 
 
Customizing a Toolbar Set 
 
Sometimes, however, you may need to customize the Toolbars even more – perhaps 
reduce the number of available tools.  This is easily accomplished by using the 
“Customize Toolbars…” option on the Toolbar context menu. 
 

1. Right click somewhere on the visible toolbars.  At the bottom of the context 
menu that pops up, choose “Customize Toolbars…”  You can also access 
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this option by going to the “Tools” menu and selecting “Customize – 
Toolbars…” 

 
 
 
The Customize Toolbars 
window opens up. 
 
Note the four tabs along the 
top of the window 
corresponding to the four 
main toolbars.   
 
Focusing on the Main toolbar, 
you can see the name of it in 
the name field, the fact that it 
is currently visible and that it 
is large in size. 
 
There are two areas dealing 
with the tool buttons.  The “Active Buttons” area shows all the tool buttons that are 
currently available on the toolbar. 
 
The “Available Buttons” area shows all the tools that you could add to the toolbar if you 
wanted. 
 
2. You can begin customizing this Proofreading Main toolbar by removing unwanted 
buttons.  For example, click on the “Help” button in the Active Button area to highlight it. 
Then click the “Remove” button just under the area to remove it from the toolbar. 
 
      
 
 
 
3. To Add a button to the Toolbar, locate a button in the Available 
Button area by scrolling along, highlight it (for example, the Silent toggle) 
and then click the “Add” button to add it to the toolbar. 
 
Once it is added, you can move it along the toolbar into a 
location you would like by clicking on it and then clicking the 
“Left” and “Right” arrows to move it (or any other tool) along the 
toolbar.  *** Always click “Apply” to save any changes you make. 
 

3. Once you have finished customizing your toolbar(s), you can save the 
Toolbar Set so your student can use it any time by clicking 
the “Save View” button.  You will be asked to name your 
Toolbar Set.  Type in a name and then click “OK”.   

 
Your student can pull up that custom Toolbar Set any time by right 
clicking on the toolbar and selecting it from the Toolbar Set list. 
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Adjusting the Program Options 
 
Some students require more support – auditory feedback WHILE composing, not just 
reading text after it is written.  To adjust the level of auditory support, you need to go to 
the Options area of the program. 
 

1. From the “Tools” menu, select “Options”.   
 
The Options window will open up.  This window has several 
“pages” which can be displayed by clicking the page titles on the 
left hand side of the window.   
 
2. Click “General” to view the General Options. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If you would like your student to have auditory feedback as they type, you can select 
how much support under the “Speak as Typing” area of General Options.  For complete 
auditory support, you may opt to have the program speak buttons and messages as 
well.  Remember to click the “Apply” button any time you make changes to save them. 
 
3. The “Reading” page gives you the ability to change how the program reads text.   
 
For example, you can choose 
a different “Speaker” from the 
drop down list. 
 
You can adjust the speed of 
reading. 
 
You can also adjust when the 
program speaks (when a 
word is double clicked for 
example) 
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4. The “Text” page gives you the ability to adjust how the program displays the 
text on a page. 

 
 
On this page you can change 
the text, background, reading 
word and reading unit colours. 
 
You can also change the 
default font. 
 
You can change the timing of 
the auto backup feature 
(important if your student tends 
to close documents frequently). 
 
Once you have made all the changes you would like, remember to click “Apply” to save 
them.  Then click “OK” to exit the Options window. 
 

5. Try typing some more in your text document to see how your changes have 
affected the word processing environment. 

 
Using the Word Prediction Feature 
 
Some students require even more support while they are writing.  Students who have 
difficulty with spelling, word finding or sentence construction may benefit from using the 
built in word prediction feature of Kurzweil 3000. 
 

1. The Word Prediction feature can be turned on by clicking the 
“Prediction” button on the Toolbar (either the Main or Writing 
Toolbar depending on what Toolbar set you are using)  

 
or by going to the “Tools” menu and selecting “Word Prediction”. 
 
When you activate Word Prediction, the floating Prediction Palette appears.   
 
2.  You can move the Prediction Palette around on your screen by clicking and 
dragging it by the title bar at the top.  You can also 
control the size, and consequently the number of 
predicted guesses, by clicking and dragging the bottom 
of the Palette to resize it.  
 
With the Prediction Palette open, start typing some new 
text in your text file.  You will see guesses appear on 
the Prediction list. 
 
You can select from this list of guesses by clicking on 
the word with your mouse or by pressing “Control – 
number of word” on your keyboard (for example, to 
choose the, you would press Control – 3) 
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2. Many times students type words that aren’t in the Prediction dictionary that 
they will be typing again at some point.  You can add words to the Prediction 
dictionary by following a two step process… 

 
a. When the student has typed the word in the text 

file, stop and highlight the word.   
 
Then click the “Spell Check” button on the Toolbar  
 
OR go to “Tools” and select “Spell Check”.   
 
This step is necessary to make sure you are not adding misspellings to the Prediction 
Dictionary.  When the Spell Check window opens, make sure the word is, indeed, 
spelled correctly and then click the “Add” 
button.  The word is now added to the main 
spelling dictionary.   
 
Click “Exit” to close the Spell Check window. 
 

b. The second step is to “Train” the 
Prediction Dictionary.  If the word is 
not still highlighted in your text, re-
highlight it. 

 
Click the “Train” button at the top of the Word 
Prediction Palette. 
 
You will be asked if you want to add the word to the Word Prediction Training – click 
“Yes” and the word has now been added and will be predicted the next time the student 
begins to type it. 
 
In this way, you can quickly add words to the Prediction feature further customizing the 
word processing environment. 
 

3. One of the most powerful ways to use the Word Prediction Feature is to 
create your own, custom Vocabulary Lists that contain 
words from a specific topic or theme the student is 
exploring in his or her writing.  To do this you create a 
new Vocabulary List and enter the custom vocabulary. 

 
a. Go to the “Tools” menu and select “Vocabulary 

Lists…” 
 

The list of currently available vocabulary lists opens 
up.  Here you can see some of the program lists – the 
ones that are selected are currently active. 
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b. To create a new Vocabulary List, 
click the “New” button. 

 
 
 
 
 
 
 
 
 
 
 

c. A new window opens up giving you 
the option of creating a vocabulary 
list from words that you type in or 
from a text file you have saved on 
your computer.  For this example, 
click the radio button next to 
“Create Vocabulary List from 
words I type”.  Then click “Next”. 

 
 
 
 

d. On the next window… 
 
 
 
Add these words to word prediction 
 
 
 
Highlight these words in word prediction 
window (choose a colour) 
 
 
Type the words in the word field 
and then click “Add” 
 
Highlight the typed word and retype to 
add another word, clicking “Add” each 
time until your list is created 
 
Click “Next” 
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e. Save your newly created Vocabulary List… 
 
In the Kurzweil 3000 folder, with the other 
Vocabulary list files… 
 
 
Give your Vocabulary List a name 
 
and click “Save”. 
 
 
 
 
Your new Vocabulary List has been saved 
and automatically activated.  If you don’t 
want it active at this time, deselect it from the 
Vocabulary List.  
 
 
 
f. Try typing some words from your 
new Vocabulary list in your text file and see 
how quickly they are predicted.    
 
 
Saving a Text File or Word Processing Document 
 
Once you have finished your document, you should save it to a location on your hard 
drive that is easy to find.   
 

1. With your document open, go to the “File” menu and select “Save” or “Save 
as…”.  The “Save as…” window will open up. 

 
 
By default, Kurzweil saves to the 
Kurzweil 3000 folder in the KESI 
folder in the My Documents 
folder. 
(path: My Documents – KESI – 
Kurzweil 3000) 
 
You can see the Sample 
Documents folder here as well. 
 

2. To create a new folder 
to hold your own text 
documents, click on 
the “Create New Folder” icon at the top of the window and name your folder. 
For example, you may want to make a file for your student’s work. 
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3. Double-click on the actual folder you created to open it.  Its name should now 
appear in the “Save in:” field at the top of the window. 

 
4. Click in the “File name” field and type in a name for your text file. 

 
5. The next step is important:  You must decide in what format your file will be 

saved.  There is a “Save as type:” drop down menu which gives you file 
format choices.   

 
By default, Kurzweil will save 
the file as a “Rich Text Format 
(.RTF)” file.   
If you save it this way, you should be able to open it with any word processing 
program, including Kurzweil 3000, and your formatting should remain fairly 
stable. 

If you think you will need to open your file with another program (for example you may 
be transferring it to another computer that only has Microsoft Word), then you should 
consider another file format like “.DOC”.  
 

6. Once you have decided on a file format, click “Save” to save the file. 
 
Accessing the Onboard Help 
 
Kurzweil 3000 has an excellent onboard database of Help topics if you 
need more information on the various tools and word processing 
features.  To go to that indexed database, select “Help Topics…” 
from the “Help” menu.   
 
For example, there 
is a link to an area 
for “Writing and 
Editing Text 
Documents” 
 
 
 
 

 
Hopefully you now 
feel confident using 
the program to 
support your 
students’ writing 
tasks. 
 
 
 
Please refer to other tutorials and demonstrations available on the Kurzweil 3000 
Resource page (http://www.setbc.org/setbc/psap_lc/docs/05_kurzweil_resource.html) for 
more information on this program. 


